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About this Reference Manual

The topics in this reference manual are presented in alphabetical order. 

Text in italics refers to a topic title.

Icons

Phase One Image Capture Software uses icons for quick access to frequently used
features. How to find reference information on these icons is given below.

For Information on: See topic:

Crop Box

Color Picker

Zoom

Curves

Tonal Range

Gradation Curve

Unsharp Masking
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For Information on: See topic:

Grid

Mask

Color Management

Color Warning

Lock

Image File Info

Capture Specification

Gradation Curve

Gradation Curve
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For Information on: See topic:

BatchTool in BatchTool Manual

Embed Copyright

Focus Tool in Focus Tool Manual

ISS Control

Quicktime Tool

Scan Progress

Settings

Phase One Image Capture Software - Reference Manual
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16-bit Plugin

Menu Item: Image ➜ Pixel Depth

See Also: Plugins

Description and Use

Phase One digital camera systems captures images in 12 bit/color and convert the
information to 8 bit/color based on the settings in Tonal Range and Gradation
Curves. By using the 16 bit file format you can in a few special setups achieve
more color information and get even softer color gradients. The extra color infor-
mation will only be valuable if you have a high-end image manipulation software
and want to make heavy post processing in the image.

Important limitations

Only high end image editing software has full support of the 16 bit file format.
Some popular image editing software packages will allow you to open a 16 bit file
but will only give you access to a limited number of features.

No extra details

The 16 bit file format will give you no extra details in the image. The capturing
resolution is still the same - only the color depth has changed. The details and
maximum print size without interpolation is not changed by going from 8 bit to
16 bit file format.

To be able to give the optimum support to the few users that can benifit from the
16-bit file format you must register at Phase One to get access to the 16-bit file
format in the Phase One Image Capture Software.
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About Phase One 

Menu Item: Macintosh: � ➜ About Phase One 3.0
PC: Help ➜ About...

Keyboard Short-cut: Macintosh: none
PC: Alt H A

Description and Use

This is an information only window showing you the version number of the
Phase One Image capture Software installed on your computer.

The information contained in the About Phase One window is often asked for by
technical support people during troubleshooting.

Phase One Image Capture Software - Reference Manual
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About Plugins

Note: Only available with Macintosh software.

Menu Item: � ➜ About Plugins...

Description and Use
This item allows you to view the software version number of the current plug-in
modules associated with your Phase One Image capture Software.

Choose from the list the plug-in you want information about. 

If you choose a Phase One camera back plug-in, you will also see detailed infor-
mation about the particular camera attached to your computer. 

You would use the information contained in the About Plugins... windows during
troubleshooting.
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Appearance

Menu Item: File ➜ Preferences...

Keyboard Short-cut: Macintosh: �Y PC: Alt E P

To Edit: Click on Appearance in the the Preference Window.

Description and Use
This panel of the Preference Window sets the layout of the Preview Window and
Toolbar icons the monitor screen. You might want to change the layout if you are
using a small monitor.

The settings in the Appearance panel are saved each time you Quit the Phase One
software.

When you start the Phase One software, the Appearance of the last session is used.

MAC only: The Toolbar buttons list contains check-boxes for each of the available
toolbar button icons. To view a toolbar icon, activate the check box. The func-
tionality of a toolbar icon can always be reached from a menu item if not shown.
For information on the menu items, see the topic for the specific icon.

Phase One Image Capture Software - Reference Manual
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The Panel Alignment thumbnails set the
preview image (shown in red) either to the
left or the right of the main panels.

The Toolbar Alignment thumbnails set
the position of the toolbar (shown in red)
relative to the preview image.
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Balloon Help

Menu Item: Help ➜ Balloon Help

Keyboard Short-cut: Macintosh: Help

Description and Use
When Balloon Help is active, moving the cursor around the screen shows pop-up
windows giving help on the underlying item.

If you only want to activate Balloon Help temporarily, hold down the help key on
the keyboard while moving the cursor over an item.
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Capture

Menu Item: Camera ➜ Capture

Keyboard Short-cut: Macintosh: �K PC: Alt C C

Icon:

Description and Use

This function starts a full scan using the scan resolution set in the Capture
Specification panel. 

The resulting image file is saved in the name and location given by the Capture
Specification and Capture File dialogs.

To start a Capture, click on the capture button.

To stop a scan prematurely,  click on the icon.

If you have changed any image-related settings the Preview button will flash to
indicate that you should take a new preview before making a Capture.
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Capture File

Menu Item: File ➜ Preferences...

Keyboard Short-cut: Macintosh: �Y PC: Alt+P

To Edit: Click on Capture File in the the Preference Window.

Description and Use

This panel of the Preference Window sets the name and destination folder of the
next captured image, the creator of the file that will be produced and which pic-
ture viewer (if any) is opened after the capture is complete.

Windows Software

The Image Folder area indicates the currently selected folder. If you wish to
change this, click on Browse... to open a standard folder selection window.

The Image File Creator area allows you to specify which file type is attributed to
your images. When Phase One is selected, the computer will associate the file
with the Phase One Image Viewer. If Adobe Photoshop is selected, association is
with the Photoshop application. This means that double-clicking on a file when
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“browsing” automatically launches the associated application.

The After Capture area allows you to select which application will be launched
when a Capture is complete. If the Open Image Using box is marked, the appli-
cation shown in the pop-up menu is started and the capture file transferred to it.
When there is no mark in this box, no application is started. If the Bring to Front
box is marked the image is displayed as the topmost window.

For the After Capture functions to work correctly, your computer’s operating sys-
tem must be “told” what applications are asociated with what file types. Consult
your operating system documentation for details.

MAC Software

Name Tab

The Name field is inherited from
the name given in Next Image on
the Capture File panel.

The Unique suffix is an addition
to the name that is added by the
Phase One software. To make files
with identical filenames unique,
activate the  Always include
unique suffix box.

The Extension drop-down list allows you to specify the extension given to the
captured file. The Samples at the bottom of the window show your choices
applied to real file-names.

Location Tab
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The Location tab indicates the
currently selected folder where
your images are saved. If the des-
tination folder is “Default”, your
images will be saved in the Phase
One Images folder. If you wish to
change this, click on New and
select the new destination folder.
This could be, for example, net-
work drives or removable media.

The Available  field shows how much space is left on the chosen volume.

Attributes Tab

The Creator Code allows you to
specify which file creator is
attributed to your images. When
Phase One is selected, the com-
puter will associate the file with
the Phase One Capture Viewer.
If Adobe Photoshop is selected,
association is with the Photoshop
application. This means that
double-clicking on a file auto-
matically launches the associated
3application.

The Extension option allows you to specify the file extension that will be append-
ed to all capture file as they are saved. The extension does not affect the file cre-
ator attribute.

When Create thumbnails is set, a thumbnail preview is added to the image file
which can subsequently be viewed by programs having a thumbnail preview
option, for example Phase One Image Capture software and Adobe Photoshop.

The After Capture sub-panel allows you to select which application will be



launched when a Capture is complete. If the Open Image Using check box is
marked, the application shown in Creator Codes is started and the capture file
transferred to it. When there is no mark in this box, no application is started.

Phase One Image Capture Software - Reference Manual
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Capture Specification

Description and Use

The Capture Specification panel allows you to specify the scan resolution, the out-
put resolution and size, the image’s filename, and to attach comments to the file.

The Scan method pop-up menu enables you to choose the input resolution set-
ting for the final shot. 

Always remember that the Scan Method is the resolution of the data coming into
the Phase One software. The output file resolution may be different, depending
upon the settings made in the Output Image panel.

There are two types of Scan method, standard and custom.

Standard Resolutions

The standard resolutions are High Resolution, Medium Resolution, Low
Resolution  and  Lowest Resolution (these may vary according to the camera
back and Settings). Each pixel in the output image matches a scanned pixel in the
camera back’s CCD. In other words, no interpolation is done.

The High Resolution setting uses all of the pixels available with your camera
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back. The lower resolution settings skip some pixels (for example, every second
pixel and every second line). This makes scanning faster and image files smaller,
though the “grain size” is increased.

Custom Resolution

When set to Custom Resolution the application may use interpolation to pro-
duce the number of pixels required to make your image. To prevent a decrease in
quality when interpolating, the maximum output-image size is restricted to 130%
of the size of an image scanned using the Highest resolution. 

Output Image

The Output Image panel allows you to specify the Width, Height and Resolution
of the capture file.

The units of measurement are selected by the pop-up menus beside the size
fields. Both metric and imperial measurements are supported.

The Height and Width values directly relate to the Crop Box on the preview
image. If you have set a Lock on either of the values, that dimension does not
change.  You might sometimes see a warning triangle

The Resolution value shows how many pixels there will be in the final image per
unit length. In normal operation you might set and Lock this to 300 pix/inch,
corresponding to 300 dpi*. Then however you set the height and width, your out-
put file will always have a 300dpi resolution.

When using a standard input resolution (highest, medium, etc.) with a specified
Crop Box, a fixed number of pixels are scanned in to form the final image. If you
change the output resolution, the Crop Box is scaled accordingly. For example,
changing the output resolution from 300dpi to 600 dpi causes the Crop Box
dimensions to be reduced by a half. 

*A 300dpi setting corresponds to printing in catalog quality (150 lines per inch / 60 lines per cm)
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When using a Custom input resolution, a variable number of pixels are scanned
in (allowable because of interpolation), thus the Crop Box size and output resolu-
tion are  not tied together in the same way. 

Note: The Phase One Image Capture Software checks the values that you enter
for size and resolution to see if they lie within the camera’s range. If out of range,
the software adjusts the dimensions and resolution to the nearest best fit. 

For more information on the  icons, see the Lock topic.

File Information

The File size information box at the bottom of the window shows approximately
how much disk space the image file will use with your chosen settings. The larger
the image and the greater the resolution, the larger the file size.

The Free information box tells you how much space is left on the media you use
to store your captures, typically the local hard disk.

The Next Image field shows what file name your next captured image will have.It
will be placed in the folder indicated by the Capture File window.

Beside the Next Image field is a disclosure triangle giving you access to a History
of recent captured files. When you choose one of the files on the list, it is opened
using the application specified in the Capture File dialog. Each time you select a
file, a new instance of the application is opened. This allows you to compare two
or more takes side-by-side.

For information on the icon, see the Image File Info topic.
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Capture Viewer

Menu Item: File ➜ Open...

Keyboard Short-cut: Macintosh: �O PC: Ctrl+O

Description and Use

The Capture Viewer enables you to examine  files made by the Phase One applica-
tion from inside your Phase One application program. It has zoom and scroll fea-
tures which allow you to get a very close look at your final takes right away without
starting up another application. 

To Zoom in, click on the image when the cursor is a (default).

To Zoom out,  change the cursor to a by holding down the Alt key and click
on the image.

To scroll around the image, change the cursor to a by holding down the Ctrl
key, or use the scroll bars.

It is also possible to have all final images opened automatically in the Capture
Viewer after they are scanned. To do this, select  Phase One in the “Open Image
Using”  panel (see Capture File topic).

To view more than one image at once, use the Open... command for each image.
To display them side-by-side, move and resize the Capture Viewer windows to suit.

The Close command closes the active Capture Viewer window.

Note for Macintosh users only: The bottom entries on the Windows menu show
you how many  Phase One windows are open. To switch between the windows,
click on the required one or use the keyboard short-cut. There are also pop-up
menus for information, zooming and navigating at the bottom of the window.

Phase One Image Capture Software - Reference Manual

19



Phase One Image Capture Software - Reference Manual

Close

Menu Item: File ➜ Close

Keyboard Short-cut: Macintosh: �W PC: Alt F C or Alt+F4

Description and Use

This command closes the active Capture Viewer window.

When there is no active Capture Viewer window, the Close command is not avail-
able.
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Color Info

drag mark

Description and Use
The Pick Position shows the  X and Y pixel-coordinates of  tip of the Color Picker.
The coordinates are measured from the upper left hand corner of the preview
image. Use the Lock function to fix the pick position (and hence the cursor view
windows)

The two cursor viewers show the area around the tip of the Color Picker. If the “Draw
color picker frame” option is set on the Color Picker panel, a frame appears in the
cursor views showing the color picker size. The gray balanced view shows preview
image data after Gray Balance calibration. The current display shows preview image
data after gamma correction, tonal range, or gradation changes. You can use the
Zoom functions in these windows, but note that color picker frames are not visible
if the zoom is less than 1:1.

Also shown in the Color Info window are the numerical values of the color chan-
nels. The color channels are by defualt shown in RGB form. 

MAC Only: If you have activated Color Management and you have chosen a
CMYK output device (for example a  CMYK printer), a CMYK colored button-
appears above the channels. By activating this, you will see the channels displayed
in CMYK form.

You can move the Color Info window to another location on your monitor screen
by dragging the Drag Mark.
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Color Management

Icon:

To Activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

See Also: Profiles

Description and Use

The Color Management function allows you to set up the Phase One application
to apply color management.

Color management is only used in the system when the Apply color management
box is checked. 

The Output data box shows you what format your output data is in –  RGB or
CMYK. You can see the RGB or CMYK values in the Color Info panel.

When clicking on the Profiles... icon you open the Profiles panel in the
Preferences window. See the Profiles topic for more information.



MAC Only: Depending on which radio button is active, color management will
be applied to the image data file, embedded as a camera profile in the image file,
leaving the image data untouched, or shown just as a preview, again leaving the
image data untouched.

The difference between the options is basically where color management informa-
tion is carried with the data file. Once color management is applied to the image,
it is difficult to remove. However, this option is best used when you use the same
camera/monitor/printer setup for each of your jobs - the color management infor-
mation will always follow the image around.

By choosing to embed the camera profile, the raw data has no color management
applied to it, but you can be sure that the color management inforamation will
always follow the image around. You can then apply color management at a later
stage using the given profile information.

By choosing only to preview the file with color management applied, the image
data is saved “as is” without profile information, but the monitor picture uses the
chosen profile so you can see the probable printed result. You could use this
option if you were sending your pictures to a third party who was going to imple-
ment color management for you.

Phase One Image Capture Software - Reference Manual
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Conversion of Images to CMYK Files

The conversion to CMYK files can either be done on the fly when the image is
captured or later in Photoshop using the same ColorSync profiles and color sepa-
ration engine.

Procedure 1 - CMYK separation with Phase One Software

1. Capture a preview and make the usual adjustments of Tonal Range,
Gradation Curve etc.

2. Click the ColorSync button and check Apply Color Management.

3. Click the Profiles button.

4. Select “Camera to Printer” and the appropriate profiles i.e. Camera:
“PhotoPhase with TG1, tungsten”: , Monitor:  “Trinitron 1.8”,
Printer:“Offset print - Euro Catalog

5. Capture the image.

The captured image will be converted from RGB to CMYK on the fly and are
ready for printing.

This procedure gives a very productive workflow.

Procedure 2 - CMYK separation via Photoshop

The procedure for doing the ColorSync separation via Photoshop.

First you must install the ColorSync filters in Photoshop. Find them on the Phase
One Software 3.0.1 CD-ROM and copy them to the Photoshop Plug-ins folder.

1. Capture a preview and make the usual adjustments of Tonal Range,
Gradation Curve etc.

2. Click the ColorSync button and check Apply ColorManagement.

3. Click the Profiles button.
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4. Select “Camera to Printer” and the appropriate profiles i.e. Camera:
“PowerPhase, TG1, Tungsten”: , Monitor:  “Trinitron 1.8”,
Printer:“Offset Euro Scale”.

5. Capture the image.

6. Open the file in Photoshop.

7. When the files is ready for the final conversion select “TIFF ColorSync
Conversion” in the Export submenu in the File menu.

8. Select an output profile. Common offset printing profiles comes with
the Phase One software. 

9. As Quality select “Best”

10. Click the Export Tiff button and give the file a name. The file will now
be stored as a separate CMYK file - ready for printing

This procedure gives full control and the possibility to store the RGB file for later
use.

Phase One Image Capture Software - Reference Manual
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Color Mode

Menu Item: Image ➜ Color Mode

Description and Use

This command on the Image menu opens the Color Mode sub-menu.  This
allows you to set the system to use full color (RGB) or only gray tones (grayscale).

Grayscale image files take only one third the hard disk space of a color file with
the same dimensions and print quality.

When you change color modes, Tonal Range and other color attribute settings will
be reset to the default for that  particular color model. If you know you are going
to change color mode, be sure to do this before changing the Tonal Range.
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Color Picker

Icon:

To Activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

Description and Use

The Color Picker allows you to select  pixels from your preview image for use as a
reference in Gray Balance, Tonal Range and Gradation operations. When the color
picker is active, the mouse cursor is a when it is placed over your preview
image. You can Lock the position of the Color Picker.

To edit Color Picker options,  double-click on the icon or select the icon in the
Cursor Tools and View Modes floating window (if displayed).

The Sample Size value determines how many pixels a color picker tool will ‘see’ at
any one time. Point Sample means one pixel. 3x3 Pixels and 5x5 Pixels mean
that the average value of either 9 or 25 pixels respectively is calculated and used by
the tool. The tip of the eyedropper is always at the centre of the 3x3 or 5x5 group
of pixels. The Draw color picker frame option allows you to see the sampled area
in the Color Info panel.
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Color Warning

Icon:

To Activate: Click on the icon

To De-activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon tab in the
Cursor Tools and View Modes floating window (if dis-
played).

Description and Use

The Color Warning dialog gives you a visual warning on your preview picture of
pixels that are saturated.

Saturated pixels have values outside the color range of the current set-up, normal-
ly 0 or 255. These values may be different if color management is applied and the
management software sets, for example, a range of 7 to 249. To see which pixels
in your preview (and hence the final image) that are saturated, click on the Color
Warning icon. Affected pixels will then have their color set to the colors shown in
the in the Color Warning window (see below).

Looking for saturated pixels is a useful guide to see the areas of your image that
might be loosing detail in the highlight and shadow areas. You avoid saturation by
adjusting the lighting conditions, the exposure, the tonal range and the gradation.

To edit the Warning colors, double-click on the Color Warning icon or select the
icon in the Cursor Tools and View Modes floating window (if displayed) to bring
up the Color Warning dialog. 



The  warning colours are changed by
clicking on the coloured patches asso-
ciated with Shadow and Highlight,
and then choosing the new colour.

By checking the Gray out image box,
all the pixels that do not have a warn-
ing associated with them are made
monochrome. This is to make it easier
to see the warning pixels.

MAC Only

The range slider shows  the current allowable range of pixels in the image. By
default this is 0 and 255. However, if color management is applied, you may need
to adjust the shadow and highlight values to suit the allowable range.

Phase One Image Capture Software - Reference Manual
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Copy

Menu Item: Edit ➜ Copy

Keyboard Short-cut: Macintosh: �C PC: CTRL+C

Description and Use

The Copy command is available only when you have selected a text field to work
in.

Use Copy in combination with Paste to transfer text data from one field to another
within the Phase One software, or to put text information onto the clipboard for
inclusion into other programs.
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Crop Box

Icon:

To Activate: Click on the icon

To Display Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

Description and Use

The cropping tool enables you to select a reduced area of the image to use in your
final work. When you have selected a cropping area, only that area will be scanned
during image capture. This offers the advantages of a quicker scan time, a smaller
image file, and optimized image composition. You should note that the Exposure
Control and Tonal Range histogram are restricted to the area within the Crop Box.

Note: A Crop Box always exists in a Preview image, but the default size is the whole
image so its boundaries cannot be seen. 

Defining a Crop Box

Select the Crop Box function. Use the mouse to point to one of the corners of the
area you wish to crop. Press and hold the mouse button as you drag the mouse
away from the original point; a black and white dashed rectangle will outline an
area that will resize as you drag. Release the mouse button to define the area.

The size of the cropped area is displayed in the Capture Specification panel.

Resizing a Crop Box

To resize the crop area, move the mouse cursor to any corner or edge of the crop
area. When at a corner or edge, the mouse cursor changes to a double arrow.
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Click and hold the mouse button. Drag the mouse to resize the area. Release the
mouse button when you are finished.

Moving a Crop Box

Move the mouse cursor inside the crop area. The mouse cursor changes to a cross
with four arrrowheads. Click and hold the mouse button and drag the entire area
anywhere on the image. Release the mouse button when the Crop Box is placed
where you want it.

Deleting a Crop Box

You can delete a crop area by placing the cropping tool cursor on the image but
outside of the crop area and clicking once with the mouse button. This effectively
re-defines the Crop Box to be full size.

Fine Tuning

The Height, Width and Resolution data fields in the Capture Specification panel
directly reflect the size of the crop in the given units. When you change these val-
ues, the size of the Crop Box is changed accordingly.

To see the Crop Box origin (top left corner), double-click on the icon or select the
icon in the Cursor Tools and View Modes floating window (if displayed). The
placement of the Crop Box is shown in this window together with its height and
width (which also give the image size in pixels).



Cursor Tools & View Modes

Icons:

To Display Double-click on any of the above icons

Description and Use

The Cursor Tools and View Modes floating window contains a panel for each of the
active functions whose icon is shown above. The window allows you quick access
to the active functions and to edit their parameters.

An example of the Cursor Tools and View Modes window

Only one cursor tool can be active at once since they define the function of the
cursor.

One or more view modes can be active at once. View modes act as “filters” on the
Preview image, and are provided for your guidance. They do not change the
image data in any way.

Phase One Image Capture Software - Reference Manual
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Cut

Menu Item: Edit ➜ Cut

Keyboard Short-cut: Macintosh: �X PC: CTRL+X

Description and Use

The Cut command is available only when you have selected a text field to work
in.

Use Cut to remove selected text from a data field and copy it to the clipboard.
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Curves

Menu Item: Image ➜ Curve

Keyboard Short-cut: Macintosh: �M PC: Alt+M

Icon:

To Display Click on the icon

To Hide: Click on the icon

The Curves window, which controls the way the camera back reacts to light of
various brightnesses.

Gradation Curve Tab

The gradation window contains a curve showing how the gradation function
maps the brightness of the pixels coming from the camera back (shown on the
horizontal axis) to the brightness of the pixels stored in the PC (shown on the ver-
tical axis). The Gray Balance and Gamma functions apply their own mappings
independent of the gradation function, wheras the Tonal Range function is closely
linked to Gradation.

A neutral gradation setting is represented as a straight diagonal line from the bot-
tom left to the upper right of the gradation graph. With this setting, all pixel levels
are evenly distributed within the tonal range. By making changes to the gradation
graph, you can hide or bring out details in selected brightness areas of your final
image - a similar process to gamma correction.

If the Preserve Color Balance box is unchecked, you can adjust the individual
channels as well as all three at once (general).

For more information about gradation and what it does to you image, read the

Phase One Image Capture Software - Reference Manual
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Understanding Gradation and Tonal Range section at the end of this topic.

The contrast control applies changes to the gradation curve that will increase
or decrease the contrast in your image. The Contrast control effectively changes
the slope of the curve between input values in the shadow range. When you use
the Contrast control, two “handles” (markers) appear on the curve. As you adjust
the contrast, the left handle moves with respect to the right one. 

The curve dialog above shows a gradation curve with contrast changed.

The brightness setting make changes that will increase or decrease the overall
brightness of your image. When you use the brightness control, one handle is
added to the curve. The Brightness control effectively changes the y-value (output
value) of the curve in the shadow region. 



The curve dialog above shows a gradation curve with brightness changed.

Making Customized Gradation Curves

You can make changes directly to a gradation curve by using the mouse to place
your own handles and reshape the curve. 

Select a point on the curve by clicking on it with the mouse. This will place a
“handle” at that point.

Handles are points on the curve that you can move with the mouse. They also
work as anchor points. The curve is automatically kept smooth, so dragging a sin-
gle handle will alter all points along the curve — except those points anchored
with other handles. 

To modify the curve, move the mouse cursor over a handle. The cursor changes
to a cross with four arrowheads. Left-click on the handle and hold down the
mouse button while you drag the handle to wherever you would like it to be.

Phase One Image Capture Software - Reference Manual
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Release the mouse button to drop the handle.

To remove a handle from the curve, just drag it away from the Gradation Window.
To remove all the handles from a curve, press the Reset button. This also applies to
the handles placed automatically by the Contrast and Brightness functions.

Saving and Loading Gradation Curves

When you change the tonal range using the Gradation Curve window, the set-
tings are automatically used in the current session for all future captures until you
either change the curve or quit the program.

Should you wish to save the current gradation values for future use, then use the
Save button on the Gradation Curve window. The Description... button on the
Save dialog allows you to add a text description to the file for easier identification
in the future. 

To Load a saved gradation curve into the current Phase One session, click on the
Load button. 

Gradation files are stored by default in the Gradation Settings folder in the Phase
One hierarchy. 

Tonal Range Tab

This tab shows the Tonal Range panel which enables you to optimize the tonal
range in your images.

The tonal  range of a digital picture is defined as:

(value of the lightest pixel) - (value of darkest pixel) +1

With Phase One cameras the maximum tonal range is 4096.

With an 8-bit TIFF picture, the maximum tonal range is 256.

For example, if your preview scan reveals, via the Color Info window, that the



brightest point in the image has a value of 159, and your darkest point a value of
10, your tonal range would be only 150 and your image would appear dark and
unclear. By setting new highlight and shadow values, you can increase the tonal
range to the full 256 levels, thereby maximizing your image’s brightness range and
definition in the highlight and shadow areas.

The Tonal Range window has a graphical area which shows a histogram of the
image data and an overlay of the current Gradation Curve.

There are three different methods for setting the highlight and shadow values:
automatic, graphical adjustment, and pixel selection. These methods can be used
separately or combined.

The Automatic Tonal Range Function

The easiest way to set the highlight and shadow values is to use Auto button. The
auto function works by analyzing the pixel values inside the Crop Box to find
highlight and shadow settings that give an optimised tonal range. When using the
Auto function, previous highlight and shadow values are overridden.
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If the Preserve Color Balance box is checked, then the color cast will also be
adjusted automatically. When unchecked, you can adjust the individual channels
yourself.

Highlight and Shadow Color Pickers 

The color pickers enable you to read pixel values and choose your highlight and
shadow values directly from your image. The Highlight color picker is the white
eyedropper in the Tonal Range window. See the Color Picker topic for a full
description of how color pickers display pixel values. You can use the Lock com-
mand with these color pickers. This is useful if you want to use the Color Info
panel to examine the effect of Tonal Range while using a pixel that is not visible
in the Color Info window as a reference.

Highlight and Shadow Sliders

The large panel in the Tonal Range window shows the current highlight and shad-
ow settings both numerically and graphically. You can use the highlight and shad-
ow sliders to change these settings directly using the mouse. 

These controls offer a good way to fine tune the settings made with the Auto
function or with the color pickers.

Histogram

The histogram shows the distribution of pixel brightnesses within the Crop Box.
Each “spike”  in the histogram represents a brightness value between 0 and 255.
The height of the spike is an indication of how many pixels within the Crop Box
have the corresponding brightness value.

Curve and Grid

The Grid shown on the Tonal Range window represents the input/output range
derived from the current gradation and tonal settings. The curve shows the cur-
rent combined tonal range and gradation mapping.
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Channel Setting

When in Color Mode and with Preserve color balance unchecked the Channel
field has four options: Red, Green, Blue, and RGB. The default display is RGB.
There is only one channel in gray mode.

The RGB option shows the full range of pixel values of all colors. Changes to the
RGB highlight and shadow values will be applied to all other colors proportional-
ly so that there will be no change in the color cast.

The three individual color displays (Red, Green, and Blue) each show the high-
light and shadow settings for that particular color channel.

Removing a Color Cast

The best way to prevent color casts is to make a new Gray Balance calibration each
time you start up your system or change your lights.

If you still see a color cast, you can use the tonal range window to adjust the high-
light and shadow points of each color channel independently. 

Target Colors

At the bottom of the Tonal Range window is a Target Colors check box. When
you activate this the target colors  range slider and color selector boxes appear..
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The default values for the shadow and highlight target colors are 0 and 255
respectively. This means that the pixel value that you choose as your shadow refer-
ence point is mapped onto a value of 0. If there are any pixels in your image with
an original value lower than the shadow reference point, they will also be mapped
onto 0, and consequently removing shadow detail.

If you now, for example, choose a target shadow value of 4 (by typing this in the
numeric box), your shadow reference point is mapped to a pixel value of 4. Those
pixels in the original image that are within a value of -4 from the shadow refer-
ence are now distinguishable in the image - whereas before they were “saturated”.
The highlight target color works in the same way. When Preserve color balance is
not checked, you can also set the target values by clicking on the target H/S color
buttonss.

You should use Target Colors with care. It is usually best to keep the shadow and
highlight target colors between 0–40 and 220–255 respectively. 10 and 240 are
good starting points. You should also try to pick gray tones as your reference
points to avoid color casts being introduced.

Adjusting the target colour is useful if, for example, the printing process does not
allow 100% white (equivalent to 255).
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The gradation curve shown on the Tonal Range graph indicates how the target
color settings affect the mapping. You will see extensions to the gradation curve
outside the grid, indicating how “negative” and “overrrange” pixels will be
mapped.

Saving and Loading Tonal Ranges

When you change the tonal range, the settings are automatically used in the cur-
rent session for all future captures until you either change the range or exit the
program.

Should you wish to save the current tonal range values for future use, then use the
Save button on the Tonal Range window. The save option opens up a file selec-
tion dialog which prompts you to give the tonal range settings file a name. You
can also add a text description to the file by clicking on the Description... button.
The text you type in here is displayed in the Load dialog. The description feature
allows you to give a meaningful account of how a saved tonal range setting affects
the picture file.

When you have decided on the name and description, click on the OK button.
The default folder for storing tonal ranges is the Tonal Range Settings folder in
the Phase One hierarchy.

To Load a saved tonal range settings file into the current Phase One session, click
on the Load button in the Tonal Range window. A file-finder dialog appears,
allowing you to select a previously saved file.

Understanding Gradation

In the Phase One digital camera system there are three channels - red, green and
blue - which are used to derive the hue, color and saturation of each pixel in an
image. For a given pixel, each channel has a value (a number) which refers to the
amount of red, green and blue light/pigment at that pixel position. The relative
ratio between the numbers and their absolute value are used to compute the  hue,
color and saturation. 
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In the camera back the numbers for each channel range in value from 0 to 4095
(giving 4096 possibilities).

Some examples of  RGB pixel values in the camera back (not the computer) are:

Saturated red = 4095, 0, 0

Black = 0, 0, 0

White = 4095, 4095, 4095

Mid gray = 2048, 2048, 2048

To express a number scale most economically in a computer, the binary system is
used. This means that to express 4096 different values, 12 digits holders are
required, each capable of being either a 1 or a 0. Each digit holder in a binary sys-
tem is called a bit. In the decennary system, 4096 requires four digit holders
(thousands, hundreds, tens and units), each having a value from 0 to 9.

Therefore, we can say that the pixels in the camera back are described by 12-bits
per color, or 36 bits in all.

In the computer, a traditionl image file contains the possibility of holding only 8-
bits per color, thus requiring 24 bits to describe the RGB value at a pixel location.
The TIFF 24-bit color specification is based on this 8-bit per color system. 16-
bits per color require a 48-bit color specification. Phase One software can produce
files with 16-bits per color files. However, you should note that since the source
data from the camera is 12-bits, the 16-bits saved in a file are dynamically expand-
ed from 12.

8-bit data has a maximum value of 255. We have seen that 12-bit data has a maxi-
mum value of 4095. There therefore needs to be a conversion process between 12-
bit data in the camera and 8-bit data in the computer.

If the conversion were linear, then using the pixel examples from before:

Saturated red, 12-bits = 4095, 0, 0
Saturated red,   8-bits =   255, 0, 0

Black, 12-bits = 0, 0, 0
Black,   8-bits = 0, 0, 0
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White, 12-bits = 4095, 4095, 4095
White,   8-bits = 255, 255, 255

Mid gray, 12-bits = 2048, 2048, 2048
Mid-gray,   8-bits = 128, 128, 128

You can see that each 8-bit value is close to or equal to 1/16 of the 12-bit value.
Close to or equal  indicates that there can be interpolation problems with convert-
ing from one system to another, since 4095/16 = 255.9375 and the maximum
permitted value is 255.

This means that the conversion process needs a look-up table to decide on the
final value. In the case of linear conversion, camera values between 4080 and
4095 map onto TIFF values of 255. Those between 4064 and 4079 map onto
254, and so on until values between 0 and 15 map onto 0 and  between 16 and
31 map onto 1. Numbers in the Phase One system are always rounded down to
the nearest integer value.

However, the exact 12 to 8 bit conversion ranges are up to you, and that is what
using the gradation tool is all about.

For example, instead of having a linear range where values from 16 to 32 map
onto 1, you can choose values of 12 to 45 to map onto 1. This obviously changes
the available ranges for mappings between 32 and 4095.

You need not worry about the re-calculation. The computer does this for you
automatically. All you need to do is visually change the mapping curve using the
gradation tool of the PC software.

Why read 12-bit data?

Most image applications use 24-bit TIFF files (8-bits-per-color-per-pixel multi-
plied by 3 colors), so you will rarely see a 12-bit image as it is read by your camera
back. But this does not mean that this extra information is useless.

When you change a gradation curve (or indeed the tonal range settings), you have
the full 4096 levels to choose from when you decide which 12-bit values map to
which 8-bit values. This means that fine changes in shade, detectable only with 12
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bit data, can be brought out with greater contrast in the final 8-bit image. 

How does gradation work?

The software uses the gradation curve to decide how to translate the incoming 12-
bit data into the 8-bit output. 

For each channel (RGB), the software uses a look-up table to find what the new
channel value should be when expressed as 8-bits. This look up table is represent-
ed graphically with the gradation curve. (Note: In fact, the look-up table also
takes into account the tonal range highlight and shadow settings, the calibration
information and any gamma correction.)

To get an idea of how this process works, imagine you are the software and you
have just read a pixel with a Red channel 12-bit brightness value of 48. Look at
the diagram overleaf of an enlarged section of a gradation curve. 

Find 48 on the horizontal input axis, look straight up to the curve, and then read
the output 8-bit value from the vertical output axis. In this case, the output value
lies between 1 and 2, but since the Phase One software rounds down, the result-
ing output value is 1. In this example, all 12-bit values from 40 to 57 will be
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mapped to an 8-bit value of 1.

The computer now reads the next input pixel in the line, and continues this pro-
cedure for each color of each pixel in the image.

Slope of Gradation Curve

Notice also in the figure that the first 50 input levels, where the gradation curve is
flattest, are converted to only 2 different 8-bit levels in the output. However, the
next 50 input levels (where the curve is steepest) are represented with 5 different
8-bit levels in the output, therefore retaining much more detail in that range.
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Embed Copyright

Icon:

To Activate: Click on the icon

To De-activate: Click on the icon

To Edit Values: Click on the icon or select the icon in the Cursor Tools
and View Modes floating window (if displayed).

Description and Use

The Embed Copyright plug-in allows you to include a copyright string in your
image. The string produced is either located in a banner at the top or bottom of
the image, or within the header or footer region. The Embed Copyright feature is
useful for ensuring that the image is traceable in the future or for putting captions
directly on the image. If you have not installed this plug-in, refer to the Software
Installation manual to find the correct procedure.

To edit the Embed Copyright string, click on the
icon in the toolbar or select the icon in the Cursor
Tools and View Modes floating window (if dis-
played). 

The background color of the banner (if the ban-
ner region is selected) is changed by clicking on
the coloured patch called background and then
choosing the new color.

The color, size and font of the text are changed
similarly.



Exit

Note: Exit is PC specific. Macintosh users should see the topic
on Quit.

Menu Item: File ➜ Exit

Keyboard Short-cut: Alt+F4

Description and Use

Selecting this entry exits the Phase One application and closes all windows associ-
ated with the Phase One software.

The non-image settings of the application at the time of exit are saved in the pref-
erences file. Any preview data will be lost as this is kept in a temporary file applic-
able to the current session only.

Image data is automatically saved when you make a capture, so you never  need
worry that a take has not been recorded.

Tonal Range and Gradation settings are only saved when you specifically do so
using the Save... option on their respective windows.
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Exposure Control

Description and Use

Exposure Meter

When a  preview scan is displayed on your screen, the meter bar in the Exposure
Control panel shows the result of measuring the value of  brightest image point
within the crop box relative to the dynamic range. 

Note: The meter bar reading can be misleading if you have only a small area of
bright pixels in your image. Always look at the image when setting the exposure.

If no crop is selected, the whole image is used. The brightest point is indicated
with a dark vertical line. This line will lie in one of the following colored areas:

• Red area above zero: This area indicates overexposure. 

• Green area at zero: This area indicates a correct exposure.

• Light green below  zero: This area indicates an acceptable but slightly
underexposed shot.

• White area below zero: This area is  numbered from -1 to -3.
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The numbers represent the number of f-stops your image is underexposed. To
correct the exposure, decrease the exposure time or open your aperture the num-
ber of f-stops indicated.

If your preview is overexposed and the marker appears in the red area, the applica-
tion is not able to tell how overexposed your shot is, only that there are pixel values
higher than the camera back is able to read. 

If you are not using a lightmeter, you should always try to underexpose your first
preview, and then adjust the exposure time until the exposure control indicator is
in the green.

Exposure Time

Adjusting the exposure time is similar to selecting the shutter speed when you use
film. Increasing the exposure time is like decreasing the shutter speed; it will
increase the amount of time the CCD is exposed, and therefore lighten the expo-
sure. 
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Gamma

Menu Item: File ➜ Preferences...

Keyboard Short-cut: Macintosh: �Y PC: CTRL+P

Description and Use

The grayscale graphic on this tab helps you set the computer monitor’s brightness
and contrast controls.

The gamma correction setting allows you to set the gamma correction of  scanned
image so that the image appears to have the correct tonal range and contrast when
viewed by your monitor or printing system.

Note: The Phase One application applies a gamma correction to the image data as
it is scanned. This means that the gamma setting you choose will always be part of
the image’s data.  You must therefore select the gamma correction to match your
color separation software’s expectation.
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Gradation Curve

Menu Item: Image ➜ Gradation Curve

Keyboard Short-cut: PC: Alt+M

Icon:

To Display Click on the icon

To Hide: Click on the icon

Description and Use

This entry opens the Gradation window, which controls the way the camera back
reacts to light of various brightnesses.

Gradation refers to the transformation of pixel levels within the Tonal Range
defined with the highlight and shadow settings.

The gradation window contains a curve showing how the brightness of the pixels
coming from the camera back (shown on the horizontal axis) are mapped to the
brightness of the pixels stored in the PC (shown on the vertical axis). 

A neutral gradation setting is represented as a straight diagonal line from the bot-
tom left to the upper right of the gradation graph. With this setting, all pixel levels
are evenly distributed within the tonal range. By making changes to the gradation
graph, you can hide or bring out details in selected brightness areas of your final
image.

For more information about gradation and what it does to you image, read the
Understanding Gradation section at the end of this topic.
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The contrast control applies changes to the gradation curve that will increase
or decrease the contrast in your image. The Contrast control effectively changes
the slope of the curve between input values 32 and 64. When you use the
Contrast control, two “handles” (markers) appear on the curve at the 32 and 64
input value positions. The handle associated with 32 moves with respect to that at
64.

The brightness setting make changes that will increase or decrease the overall
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brightness of your image. When you use the brightness control, one handle is
added to the curve.

The Brightness control effectively changes the y-value (output value) of the curve
at input values 32 and 64. When you use the Brightness control, two “handles”
(points) appear on the curve at the 32 and 64 input value positions. Both handles
move up and down by the same amount when the brightness control is adjusted.

Changing Brightness and Contrast

Click on the Up or Down arrow under the appropriate heading in the Gradation
window to increase or decrease the image brightness or contrast. Click several
times to apply further adjustment.

The numerical field next to the Up and Down buttons shows the relative change
you have applied. The graph shows the new gradation curve that results from
your changes. The preview image
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Making Customized Gradation Curves

You can make changes directly to the gradation curve by using the mouse to place
handles and reshape the curve. You can combine contrast, brightness, and custom
changes in any order.

1. Apply handles to the curve.

Select a point on the curve by clicking on it with the mouse. This will place a
“handle” at that point.

Handles are points on the curve that you can move with the mouse. They also
work as anchor points. The curve is automatically kept smooth, so dragging a sin-
gle handle will alter all points along the curve — except those points anchored
with other handles. 

When you use the Brightness and Contrast buttons, handles are automatically
applied to the curve at the input values 32 and 64, and the curve is adjusted
appropriately. When you make adjustments with these buttons, existing handles
remain anchored, as they do when making custom adjustments with the handles.
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2. Use the handles to modify the curve.

Move the mouse cursor over a handle. The cursor changes to a cross with four
arrowheads. Left-click on the handle and hold down the mouse button while you
drag the handle to wherever you would like it to be. Release the mouse button to
drop the handle.

3. Removing a handle from the curve.

To remove a handle from the curve, just drag it away from the Gradation
Window.  To remove all the handles from a curve, press the Reset button. This
also applies to the handles placed automatically by the Contrast and Brightness
functions

Saving and Loading Gradation Curves

When you change the tonal range using the Gradation Curve window, the set-
tings are automatically used in the current session for all future captures until you
either change the curve or exit the program. If you start a New Session or Exit the
Phase One application, the gradation curve values will be lost.

Should you wish to save the current tonal range values for future use, then use the
Save button on the Gradation Curve window. The save option opens up a file
selection dialog which prompts you to give the gradation curve settings file a
name and a folder location. When you have decided on the name and location,
click on the OK button.

To Load a saved gradation curve settings file into the current Phase One session,
click on the Load button in the Gradation Curve window. A file-finder dialog
appears, allowing you to select a previously saved file. 

Understanding Gradation

See the Curves topic.
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Gray Balance

Menu Item: Camera ➜ Gray Balance

Keyboard Short-cut: Macintosh: none PC: Alt E P

Description and Use

Select this command to set the application into Gray Balance mode.

Camera gray balance calibration helps to ensure accurate color captures. Do a gray
balance calibration each time you change your lighting arrangement, or at any
time you notice your system is not capturing colors correctly. Phase One also rec-
ommends that you do a gray balance each time you start the software to ensure
that your color captures are as perfect as possible before the image is manipulated
in the computer.

Gray tones are “colors” that are defined as having equal intensities of red, green
and blue pigment. When the three lines of CCD sensors in the digital camera
back see a gray patch in an image, they should produce the same electrical output.
Depending upon the lighting conditions (different lights have different propor-
tions of red, green and blue wavelengths), the output from each of the RGB sen-
sors may not be equal. Gray balance calibration ensures that for a particular set-up
the outputs are equal. Gray balancing applies a scaling factor to the RGB levels of
the captured image.

When doing a Gray Balance use an evenly colored, light gray object, such as a test
card that contains a grayscale. Use the lights you plan to use on your subjects.
Focus your camera on the gray object and make sure the gray object is evenly and
adequately lit.

The Gray Balance window has three cursor viewer displays of the preview image.
You can use the Zoom functions in these windows.
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The Unbalanced display shows the image as
captured by the camera (but including
Gamma correction).

The If selected display shows how the
image would be modified if the pixel under
the Color Picker cursor was to be used as the
reference for correction.

The Pick Position shows the position of the
Color Picker cursor.

The Current display shows the preview
image after the current gray balance calcula-
tion is applied.

When you click the mouse button over a
pixel its RGB values are used to compute
scaling factors which will equalize your cho-
sen color values.

If you are not satisfied with the effect on
the image, click on another part of the gray
area in the image.

When you are satisfied with the image, click on Apply to keep the new gray bal-
ance values and to return to the Preview Window.

If you wish to leave the gray balance window without setting a new gray balance,
click on Cancel.

If you have made a number of choices and the result is not satisfactory, you can
use the Reset button to give no gray balance correction. The effect of reset is to
use the image data exactly as received from the camera without any correction(but
including Gamma correction).

If you have previously applied a gray balance correction to the image, you can
recall the effect this had on the image by clicking on the Restore button.

See the Lock topic for details on how locking the Color Picker affects the Gray
Balance window.
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Grid

Icon:

To Activate: Click on the icon

To De-activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

Description and Use

This is a toggle command that overlays either a square grid or a set of crosshairs
on the image preview area. Theses are for guidance only, and are not part of the
image itself.

You use them to align an image in the vertical and horizontal planes. That is, you
adjust the physical positioning of your subject after making a preview and seeing
how the image aligns relative to the grid or crosshairs. You can move the crosshair
target around the preview image by dragging it.

When a grid is selected, the number of  horizontal and vertical lines is as specified
in the Grid panel. To change the number, double-click on the icon or select the
icon in the Cursor Tools and View Modes floating window (if displayed), then enter
new values.

To change the colour of the grid or crosshairs, click on the coloured patch on the
Grid panel.
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Hide Floating Windows

Menu Item: Windows ➜ Hide Floating Windows

Keyboard Short-cut: Macintosh: �H PC: Alt W H

Description and Use

When you select this command for the first time in a session, all the floating win-
dows that the Phase One application has control of are temporarily closed (hid-
den).

By selecting Hide Floating Windows again, the hidden windows re-appear.

You might use this command to “tidy-up” your screen if there are too many win-
dows open or to see the whole preview image without it being covered by floating
windows.
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Image File Info

Icon:

To Edit Values: Click on the icon.

Description and Use

This pop-up window allows you to attach Artist, Copyright, Computer and
Description information to the image file header, but only when the Store image
information in capture file option is checked. 

Storing image information is useful for cataloguing your images.

The text editing features (Cut, Copy, Paste and Select All) are available when this
window is open.
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ISS Control Plugin

Icon:

To view Window: Click on the icon or select the icon in the Cursor Tools
and View Modes floating window (if displayed)

To close Window: Click on the icon

See Also: Plugins

Description and Use

Note: This icon is only displayed when the ISS plug-in has been installed.

Note: Only one shutter  plug-in must be installed, otherwise a communications
conflict will occur. If you have more than one shutter plug-in installed (in the
Phase One plug-ins/utility folder), you must remove all except the shutter plug-in
you intend to use. To install a shutter plug-in, choose Custom during the installa-
tion procedure.

The ISS (Intelligent Shutter System) is an electronic shutter and aperture for use
with large format cameras. Phase One software supports full remote control of the
ISS via a serial port on your computer.

The ISS window gives you access to the control functions of the ISS system,
allowing you to set the size of the ISS aperture to within 1/10 of an f-stop.
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Load Preferences...

Menu Item: File ➜ Load Preferences...

Description and Use
The Load Preferences... function allows you to load personal set-ups for the Phase
One Image Capture Software.

Any changes you make to the program settings (for example position of the tool-
bar, preview windows, gray balance settings, and so on), are always saved in a file
called “Phase One Preferences “ each time you end a session. They are automati-
cally loaded again the next time you re-start the program.

However, if there is more than one photographer using the system, each person
can save their preferred camera and screen set-up, ready to be recalled next time
they use the system using the Load Preferences... function.

Each time you invoke Load Preferences..., a file-finder dialog box is displayed,
allowing you to search for and open your personal preferences file.

See also Save Preferences...
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Lock

Icon: ( Shown locked and unlocked)

To Activate: Click on the lock icon or, when in Color Picker mode,
hold down the Alt key and click on the desired pixel.

To De-activate: Click on the lock icon

Description and Use

Some numerical data fields in the Phase One application are able to be locked.
This means that the data does not change until the data field is unlocked again.

Locking a pick position when in Color Picker mode stops the cursor view windows
following the color picker. This is useful when you want to continuously monitor
the effects of your Gray Balance, Tonal Range and Gradation changes in a critical
area.

Locking the data fields in the Capture Specifications panel is useful when you want
to produce an image with a specific size or resolution.
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Maintenance

Menu Item: Camera ➜ Maintenance

Description and Use

This function opens up a dialog box that allows you to move the CCD sensor to
the middle of the scan area.

You would want to do this when cleaning the CCD sensor. See Care and Cleaning
in your camera back user’s guide.
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Mask

Icon:

To Activate: Click on the icon

To De-activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

Description and Use

The Mask function allows you to “hide” areas of your preview image that are not
within the Crop Box. This is useful when non-selected parts of the preview image
distract  you from seeing your proposed composition correctly. In effect the mask
is adding a frame around your selected capture area. 

To edit the Mask values, double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed). 

The Opacity value is changed by
moving the slider or typing in a
percentage between 0 and 100.
Reduce the opacity value if you
wish to “see” behind the mask.

The mask colour is fixed within the
grayscale range.

The Draw Crop Box option allows you to turn the dotted outline of the Crop Box
on and off. When set off, you are still able to use the Crop Box resize and move
tools.
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Open...

Menu Item: File ➜ Open...

Keyboard Short-cut: Macintosh: �O PC: Ctrl+O

Description and Use

The Open... command allows you to open a captured image file using the Phase
One Capture Viewer.

A file selection dialog appears from which you can select the captured image you
wish to view. The default folder for the file selection dialog is the folder selected
by the Capture File option .
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Orientation...

Menu Item: Camera➜ Orientation...

Keyboard Short-cut: Macintosh: none PC: Alt C O

Description and Use

This function allows you to set the orientation of the preview image, making it
easier to make composition and colour judgements, for example when making
“landscape” captures.

After changing the Orientation, the effect is applied only when the next Preview is
made.

The system default is with zero rotation. If you set a new orientation, it is only
valid until you Quit the program.

Note: Rotation only applies to Preview images (not a Capture)
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Paste

Menu Item: Edit ➜ Paste

Keyboard Short-cut: Macintosh: �V PC: CTRL+V

Description and Use

The Paste command is available only when you have selected a text field to work
in.

Use Paste in combination with Copy to transfer text data from one field to another
within the Phase One software, or to get text information from the computer’s
clipboard.
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PhotoPhase Control

Note: This window is only available when you have a
PhotoPhase camera back attached to your computer.

Menu Item: Camera ➜ Settings

Keyboard Short-cut: Macintosh: none PC: Alt C S

Icon:

To Activate: Click on the icon

Description and Use

The Settings command displays the PhotoPhase Camera control window.

Use the PhotoPhase Control window to set the equivalent ASA rating for your next
image and what film curve you might want to use. For information on film
curves, please see the PowerPhase Control topic.
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Plugins

Description and Use

Plugins are software packages that add extra functionality to the Phase One soft-
ware. Some plug-ins are included with the Phase One software and you are free to
install these if you would like to use the facilities they offer. Other Plugins are for
use with cameras or other hardware. These must be purchased as required. 

Plug-ns can be installed (“plugged in”) at any time. To do this, start the software
install procedure (see the Software Installation manual) and select the Custom
Install option. Altertnatively, you can drag-and-drop the plugin into the plugins
folder.. You can then select which plug-ins to install. To find out what plug-ins are
intalled, click on About Plugins menu. Below are some typical plugin options:

For Information on: See topic:

BatchTool in BatchTool Manual

Embed Copyright

Focus Tool in Focus Tool Manual

ISS Control

Quicktime Tool

Scan Progress
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PowerPhase Control

Note: This window is only available when you have a
PowerPhase camera back attached to your computer.

Menu Item: Camera ➜ Settings

Keyboard Short-cut: Macintosh: none PC: Alt C S

Icon:

To Activate: Click on the icon

Description and Use

The Settings command displays the PowerPhase camera control panel.
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Film Curve

A film curve is a Gradation type curve that can be loaded with the camera. A film
curve makes the camera behave in a non-linear way, pre-correcting your data
before it enters the computer. Example film curves are shown below:

The information button at the side of the pop-up list allows you to graphically see
the effect the curve on the transfer function. An example is shown below that
extends the highlight details and provides natural black levels.

Film curve files are provided with the software and are stored in the Film Curves
folder.

Some of the film curves provided automatically exclude sensitivity and scan set-
tings if the system would be overranged by using them.

You should always take a new preview after changing the film curve.

Setting the Task

The Capture Conditions panel allows you to select the type of work that you will
be doing with your PowerPhase camera. 
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When set to Higher Shadow Detail, the Phase One software maximizes the con-
trast ratio of the image, an important factor when capturing transparencies or
other type of “finished” artwork where detail in the shadow and highlight areas lie
close together.  Maximizing the contrast ratio reduces the sensitivity, but this is
not considered to be a hinderance, since lighting levels are not so critical when
scanning flat artwork.

When set to Studio Work, the sensitivity is maximized, giving you two f-stops
more than when set to Slide Reproduction. This allows you a lot more freedom in
choosing lighting conditions and aperture size, since up to 1600 ASA is available.

Sensitivity Setting

After you have chosen the Capture Conditions, you should choose the Sensitivity
to match the type of finished product you need. A rule of thumb is that the lower
the sensitivity, the higher the Available Resolution (file size).
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Preview

Menu Item: Camera ➜ Preview

Keyboard Short-cut: Macintosh: �J PC: Alt C P

Icon:

To Activate: Click on the icon

See Also: Preview Crop

Description and Use

This function starts a preview scan. Preview scans are made at very low resolution;
this means that a  preview image takes less time to scan, meaning screen updates
are quicker when the effect of changes are shown. 

Super Preview scans are made at twice the resolutionof preview; for more informa-
tion see the Super Preview topic.

Making a Preview is similar,  in composition terms, to taking a Polaroid shot of a
particular scene. However, the Preview image is used extensively for judging color
balance and exposure, so its use is critical for producing good final images.

The result of a preview scan is shown in the Preview Window, selected by clicking
on the Preview tab at the bottom of the Preview Window.

Note: If the Preview outline is flashing, this indicates that you have changed one
or more settings affecting the picture and you are advised to make a new preview
scan.

To start a preview, click on the Preview button.

To stop a preview prematurely, click on the icon.



Preview Crop

Menu Item: Camera ➜ Preview Crop

Keyboard Short-cut: Macintosh: �I

Icon:

To Activate: Click-and-hold on the Preview button for more than 0.1
second, then select Preview Crop

See Also: Preview and Super Preview

Description and Use

Similar to Preview or Super Preview, this function starts a Preview scan, but only
the crop area is updated. This makes taking previews even quicker, especially
when there are long exposure times involved.

The result of a preview scan is shown in the Preview Window, selected by clicking
on the Preview tab at the bottom of the Preview Window. Remember, only the
crop area is updated. Preview information outside the crop area remains “as is”.

Note: If the Preview button is flashing, this indicates that you have changed one
or more settings affecting the picture and you are advised to make a new preview
scan.

To start a preview crop, click-and-hold on the Preview button for more than 0.1
second, then select Preview Crop.

To stop a preview prematurely, click on the icon.
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Preview/Super Preview Tab

Description

The Preview/Super Preview tabs are part of the main user interface for the Phase
One Image Capture Software. They are located at the bottom of the preview area.

The Super Preview window behaves in a similar fashion to the preview window.
The resolution is twice as high, therefore the scan takes twice as long to complete.
You can reduce scanning time by activating the Preview Crop command.

You should note the apart form the crop outline box, the Preview Window and the
Super Preview Window are independent.

The most important features of the Super Preview Window are shown in the
sketch in the Preview Window topic.



Preview Window

Description

The Super Preview Window is part of the main user interface for the Phase One
Image Capture Software. It is accessed by clicking on the Super Preview tab at the
bottom of the preview area. The most important features are shown in the sketch
below
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Image Area
Your preview image is
displayed here when the
scan is finished.

Exposure Time
To change the expo-
sure time, move the
slider left and right
with the mouse.

Preview
Click on this button

to start a preview
scan.

Capture
Click on this button to

start a capture scan.

Capture Specification
This panel gives you
information about the
name and size of
your image

Color Info
This panel tells you
about the color of the
selected pixel

Cursor Tools and View Modes
Use these icons to activate differ-
ent cursor tools and view modes
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Profiles

Note: Profiles is Macintosh specific. 

Icon:

Menu Item: File ➜ Preferences...

Description and Use

The Profiles panel allows you to specify the settings to be used with ColorSync,
the color management system for Macintosh computers. Read the small discus-
sion at the end of this topic for more information on ColorSync and its terms.

The Matching field has two options, Camera to monitor and Camera to printer.

When set to Camera to monitor, the camera profile is matched (targeted) directly
to the monitor profile. You would use this when the image is going to be edited
on screen by another image processing application (or example Photoshop) before
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Profiles

A file containing information about the color reproduction capabilities of a
device, such as a a digital camera, a monitor or a printer is called a Profile.
Commonly, two profiles (source and output) are used during a color matching
session. 

A source profile represents the color gamut of a device from which an image was
originated. For example, with an image captured by a Phase One digital camera,
the camera profile is the source profile. If an image is created and viewed on a
monitor, then the monitor profile is the source profile.

An output profile represents the color gamut of a device on which an image is to
be outputted. For example, if an image is to be printed on a color printer, then
the printer's profile is the output profile. Or, if an image is to be viewed on the
monitor, the monitor profile is the output profile. In the publishing arena, the
printer profile usually refers to the profile developed for an imagesetter/film-based
proofing combination (e.g. MatchPrint) or for a particular offset press.

Proofing is the process of using one device to predict the output of an image on
another device. A proofer profile represents the device which is used for the pre-
diction. For example, if an image whose output on a color printer is to be proofed
on a monitor, the monitor profile will be the proofer profile.

Rendering

Because of the differences among devices' color capability, different methods exist
for applying color matching to an image. This matching style or rendering intent
is usually selected according to the content of the image.

A  perceptual  matching style gives the most pleasing reproduction given the
capabilities of the devices involved. It gently squeezes the entire source gamut so
that it just fits inside of the destination gamut. The hue is always preserved. This
is the most commonly used style, especially for reproduction of photographic
images. 

A  colorimetric matching style reproduces colors exactly the same as the eye can
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printing. When set to Camera to Printer, the camera profile is matched to the
specified printer profile. It is also further matched to the monitor profile so that
the colors seen on the monitor screen during preview are close to the colors pro-
duced by the printer., allowing soft-proofing.

The Profiles sub-panel contains three items; Camera, Monitor and Printer. Use
the pop-up menus to select the profiles according to the equipment you are work-
ing with – for example, if you have a PowerPhase camera back with an AR1 filter
installed, select “AR1 Daylight for PowerPhase” as your profile.The “ Extra
Saturation” profile adds more color saturation to the image.

The Matching panel has two entries, Rendering intent and Rendering quality.
Use the pop-up menus to select the rendering type you want with the current set-
up. (See below for a discussion of the rendering types available.) The default
intent is “Perceptual” and the default quality is “Normal”.

About ColorSync

ColorSync is a process of making a controlled transformation of color values gen-
erated from one device to values intended for another device. Imaging devices
such as displays, printers and Phase One cameras are only capable of using a sub-
set of all visible colors. The color subset that a device is capable of reproducing is
called its color Gamut.

In general, different devices show the same color differently, so when two or more
devices are used together (e.g., a digital camera plus printer or digital camera plus
monitor), it is very unlikely their gamuts will match. In these cases the gamuts
must be manipulated to resolve these differences in a pleasing way. This process is
called color matching (gamut mapping).
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distinguish. This may result in clipping of certain colors which can not be repro-
duced on a device. 

Colorimetric matching can further be divided into relative colorimetric matching
and absolute colorimetric matching, where relative matching accounts for the
ability of the human eye to automatically adapt to the surround white (e.g., white
of the paper the image is printed on), and absolute does not. Colorimetric match-
ing is most commonly used for reproducing Logo colors where the exactness of
the color is important.

Saturation matching best preserves the vividness of the image. This expands and
contracts the source gamut so that it exactly fills the destination gamut.
Therefore, fully saturated source colors always map onto fully saturated destina-
tion colors. This style is mostly used for reproduction of business graphics and
presentation graphics including graphs and pie charts.

Matching quality

The matching quality indicates the overall computation precision of a particular
matching session. Higher computation precision requires more run-time memory.
It is always best to use the highest matching quality your system allows.
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Quicktime Tool

Menu Item: View ➜ QT...

Keyboard Short-cut: Macintosh: �A

Icon:

To Activate: Click-and-hold on the Preview button for more than 1
second, then select Preview Crop

See Also: Preview and Super Preview

The QuickTime tool allows you to do batch scanning to produce QTVR files.
QTVR is an acronym for QuickTime Virtual Reality. This is a specification for
animation files used in multimedia presentations, typically on the Internet.

Check the Make QuickTime VR object
box if youwant to generate a Quicktime
VR file from all the captures of the next
batch.

If you expect the QuickTime file to be used
on a PC, be sure to set Flatten File.

To clean up your disk-space as you go,
check the Delete original files box. This
removes the original TIFF files when the
QTVR file is ready. Note: Be sure that the
Open Image after Capture option is not
active (see the Capture File topic)

You can apply a scaling factor from 25% to
100% using the Scale list. Scaled images
may have increased aliasing effects.



If you have installed the QTVR Step Control plugin, you can gain control of the
turntable by checking the Turntable box. If you do this, remember not to change
the settings of the turntable control directly . The QuickTime dialog will take
control when necessary.

If you choose the Fast Scanning option, the camera will not recalibrate between
captures. Note: Fast Scanning should only be used with fast exposure times.

The Images to record item is the total number of images that will be captured.
The Images recorded field shows you how many images have been captured.

Clicking on this icon accesses the QuickTime Settings dialog. 

The settings you choose in
this dialog will depend
upon your final media.

The higher the quality and
the frame rate, the larger
the final file size.

For normal use, set the
parameters as shown in the
dialog example given here
*(left).

Click on OK when you
have selected the appropri-
ate parameters.

When you have completed all your choices, start the QTVR capture process by
clicking on the Go icon.
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Quit

Note: Quit is Macintosh specific. PC users should refer to the
Exit topic.

Menu Item: File ➜ Quit

Keyboard Short-cut: �Q

Description and Use

Selecting this entry exits the Phase One application and closes all windows associ-
ated with the Phase One software.

The non-image settings of the application at the time of exit are saved in the pref-
erences file. Any preview data will be lost as this is kept in a temporary file applic-
able to the current session only.

Image data is automatically saved when you make a capture, so you never  need
worry that a take has not been recorded.

Tonal Range and Gradation settings are only saved when you specifically do so
using the Save... option on their respective windows.
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Save Preferences...

Menu Item: File ➜ Save Preferences...

Description and Use

Save Preferences... brings up a file location window that allows you to specify
where the preferences of the current session will be saved. 

Typically you would use this option if there is more than one user or
camera/lighting set-up associated with the system. That is, each user or set-up can
have a settings file that can be loaded in using the Load Preferences... function
each time the the user or set-up changes.

Phase One recommend that to keep your files in order you create sub-folders of
the Phase One Application folder named “Users” and “Set-ups”. You can then
save the current session in the appropriate folder, ready for recalling at a later date.
By using sub-folders you will minimize the time spent looking for the correct file
to open.

When you end a Phase One Image Capture Software session, the settings at that
time are automatically saved in the default preferences file. This means that the
same settings will be loaded in next time you start the application.
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Scan Progress

Menu Item: View ➜ Viewmodes➜ Scan Progress

Icon:

To Activate: Click on the icon

To De-activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

Description and Use

The Scan Progress  plug-in allows you to see how far a scan is progressing in the
preview window. If you have not installed this plug-in, refer to the Software
Installation manual to find the correct procedure.

To edit the Scan Progress display, double-click on the icon or select the icon in the
Cursor Tools and View Modes floating window (if displayed). 

The Opacity value is changed by moving the
slider or typing in a percentage between 0
and 100. Reduce the opacity value if you
wish to “see” behind the progress indication

The indication color is changed by clicking
on the coloured patch and then choosing the
new colour.
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Select All

Menu Item: Edit ➜ Select All

Keyboard Short-cut: Macintosh: �A PC: CTRL+A

Description and Use

The Select All command is available only when you have selected a text field to
work in.

Use Select All to highlight all the text in a data field. You are then able to Copy or
Cut this text.
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Settings

Menu Item: Camera ➜ Settings

Keyboard Short-cut: Macintosh: none PC: Alt C S

Icon:

To Activate: Click on the icon

Description and Use

This command displays the control panel for the digital camera back currently
attached to your system.  From this panel you can control the sensitivity (the
equivalent ISO rating) of the camera.

The control panel that appears depends upon the camera currently attached to
your system. For details of the different control panels, refer to the topic with the
same name as the camera back.
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Sinar Expolux Shutter

Icon:

To view Window: Click on the icon or select the icon in the Cursor Tools
and View Modes floating window (if displayed)

To close Window: Click on the icon

See Also: Plugins

Description and Use

Note: This icon is only displayed when the Sinar Expolux Shutter  plug-in has
been installed.

Note: Only one shutter  plug-in must be installed, otherwise a communications
conflict will occur. If you have more than one shutter plug-in installed (in the
Phase One plug-ins/utility folder), you must remove all except the shutter plug-in
you intend to use. To install a shutter plug-in, choose Custom during the installa-
tion procedure.
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The Expolux shutter is an elec-
tronic shutter and aperture for
use with large format cameras.
Phase One software supports full
remote control of the Expolux
via a serial port on your comput-
er.

The Expolux Shutter  window
gives you access to the control
functions of the Expolux Shutter
system, allowing you to set the
size of the aperture, etc.

Note: Shutter control is only available when the Active box is checked, even
though the plug-in is installed.

The Full Open button opens the aperture to its full extent. Use this for manually
focussing  your subject. 

The Shut Down button moves the aperture until it is in the position correspond-
ing to the f-stop you have set on the Aperture slider. Use this to manually check
the depth of field, composition, etc. 

When you preview or capture a picture using the Expolux shutter controlled via
Phase One software, the shutter is always automatically set to the Aperture size set
on the slider, regardless of the previous aperture position, for example Full Open.

The Lens field in the dialog box is for information only. This shows which lens
the Expolux shutter has attached to it, and therefore what range of f-stops are dis-
played. The lens information is gathered from an electronic tag attached to the
lens that mates with the Expolux hardware.



The Preferences dialog box
(accessible via the preferences
icon on the shutter control dia-
log) will have an entry if you
have a shutter installed. On this
dialog you can decide which port
the Expolux is connected to.
Choose either Modem Port or
Printer port, whichever is free in
your system.

The Connection options allow you to decide the state of the Expolux communi-
cations path when the Phase One software starts. If you find you are getting con-
flicts in your system because a port is already in use, then Deactivate on start is a
good option to choose. The Remember last state option sets the Active box in the
same condition as you last left it (i.e. either set or not). Setting Activate on start
activates the Expolux shutter every time the Phase One software starts.
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Studiokit Control

Note: This window is only available when you have a
PowerPhase camera back attached to your computer.

Menu Item: Camera ➜ Settings

Keyboard Short-cut: Macintosh: none PC: Alt C S

Icon:

To Activate: Click on the icon

Description and Use

The Settings command displays the Studiokit camera control window.

Use the Studiokit Control window to set the equivalent ASA rating for your next
image and what film curve you might want to use. For information on film
curves, please see the PowerPhase Control topic.
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Super Preview

Menu Item: Camera ➜ Super Preview

Keyboard Short-cut: Macintosh: �J PC: Alt C P

Icon:

To Activate: Click on the icon

See Also: Preview Crop

Description and Use

This function starts a Super Preview scan if you have the Super Preview tab on the
Preview Window. Super Preview scans are made at twice the resolution of a preview
scan; for more information see the Preview topic.

Super Previews are independent of  Previews.

Making a Super Preview is similar,  in composition terms, to taking a Polaroid
shot of a particular scene. However, the the Super Preview image is used extensive-
ly for judging color balance and exposure, so its use is critical for producing good
final images.

The result of a super preview scan is shown in the Super Preview Window, selected
by clicking on the Super Preview tab at the bottom of the Preview Window.

Note: If the Preview button is flashing, this indicates that you have changed one
or more ssettings affecting the picture and you are advised to make a new super
preview scan.

To start a super preview, click on the Preview button.

To stop a super preview prematurely, click on the icon.
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Tonal Range

Menu Item: Edit ➜ Preferences...

Keyboard Short-cut: PC: Alt E P

Icon:

To Activate: Click on the icon

To De-activate: Click on the icon

To Edit Values: Double-click on the icon or select the icon in the Cursor
Tools and View Modes floating window (if displayed).

Description and Use

This entry opens the Tonal Range window, which enables you to optimize the
tonal range in your images. 

The tonal  range of a digital picture is defined as:

(value of the lightest pixel) - (value of darkest pixel) +1

With Phase One cameras the maximum tonal range is 4096.

With an 8-bit TIFF picture, the maximum tonal range is 256.

For example, if your preview scan reveals, via the Color Info window, that the
brightest point in the image has a value of 159, and your darkest point a value of
10, your tonal range would be only 150 and your image would appear dark and
unclear. By setting new highlight and shadow values, you can increase the tonal
range to the full 256 levels, thereby maximizing your image’s brightness range and
definition in the highlight and shadow areas.

The Tonal Range window has a graphical area which shows a histogram of the
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image data and an overlay of the current Gradation Curve.

There are three different methods for setting the highlight and shadow values:
automatic, graphical adjustment, and pixel selection. These methods can be used
separately or combined.

The Automatic Tonal Range Function

The easiest way to set the highlight and shadow values is to use Auto button. The
auto function works by analyzing the pixel values inside the Crop Box to find
highlight and shadow settings that give an optimised tonal range. When using the
Auto function, previous highlight and shadow values are overridden.

If the Preserve Color Balance box is checked, then the color cast will also be
adjusted automatically. When unchecked, you can adjust the individual channels
yourself.

Highlight and Shadow Color Pickers 

The color pickers enable you to read pixel values and choose your highlight and
shadow values directly from your image. The Highlight color picker is the white
eyedropper in the Tonal Range window. See the Color Picker topic for a full
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description of how color pickers display pixel values. You can use the Lock com-
mand with these color pickers. This is useful if you want to use the Color Info
panel to examine the effect of Tonal Range while using a pixel that is not visible
in the Color Info window as a reference.

Highlight and Shadow Sliders

The large panel in the Tonal Range window shows the current highlight and shad-
ow settings both numerically and graphically. You can use the highlight and shad-
ow sliders to change these settings directly using the mouse. 

These controls offer a good way to fine tune the settings made with the Auto
function or with the color pickers.

Histogram

The histogram shows the distribution of pixel brightnesses within the Crop Box.
Each “spike”  in the histogram represents a brightness value between 0 and 255.
The height of the spike is an indication of how many pixels within the Crop Box
have the corresponding brightness value.

Channel Setting

When in Color Mode and with Preserve color balance unchecked the Channel
field has four options: Red, Green, Blue, and RGB. The default display is RGB.
There is only one channel in gray mode.

The RGB option shows the full range of pixel values of all colors. Changes to the
RGB highlight and shadow values will be applied to all other colors proportional-
ly so that there will be no change in the color cast.

The three individual color displays (Red, Green, and Blue) each show the high-
light and shadow settings for that particular color channel.

Removing a Color Cast

The best way to prevent color casts is to make a new Gray Balance calibration each
time you start up your system or change your lights.



If you still see a color cast, you can use the tonal range window to adjust the high-
light and shadow points of each color channel independently. 

Target Colors

At the bottom of the Tonal Range window is a Target Colors check box. When
you activate this the target colors  range slider and color selector boxes appear..

The default values for the shadow and highlight target colors are 0 and 255
respectively. This means that the pixel value that you choose as your shadow refer-
ence point is mapped onto a value of 0. If there are any pixels in your image with
an original value lower than the shadow reference point, they will also be mapped
onto 0, and consequently removing shadow detail.

If you now, for example, choose a target shadow value of 4 (by typing this in the
numeric box), your shadow reference point is mapped to a pixel value of 4. Those
pixels in the original image that are within a value of -4 from the shadow refer-
ence are now distinguishable in the image - whereas before they were “saturated”.
The highlight target color works in the same way. When Preserve color balance is
not checked, you can also set the target values by double/clicking on the S or H
panels.
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You should use Target Colors with care. It is usually best to keep the shadow and
highlight target colors between 0–40 and 220–255 respectively. 10 and 240 are
good starting points. You should also try to pick gray tones as your reference
points to avoid color casts being introduced.

Adjusting the target colour is useful if, for example, the printing process does not
allow 100% white (equivalent to 255).

The gradation curve shown on the Tonal Range graph indicates how the target
color settings affect the mapping. You will see extensions to the gradation curve
outside the grid, indicating how “negative” and “overrrange” pixels will be
mapped.

Saving and Loading Tonal Ranges

When you change the tonal range, the settings are automatically used in the cur-
rent session for all future captures until you either change the range or exit the
program.

Should you wish to save the current tonal range values for future use, then use the
Save button on the Tonal Range window. The save option opens up a file selec-
tion dialog which prompts you to give the tonal range settings file a name. You
can also add a text description to the file by clicking on the Description... button.
The text you type in here is displayed in the Load dialog. The description feature
allows you to give a meaningful account of how a saved tonal range setting affects
the picture file.

When you have decided on the name and description, click on the OK button.
The default folder for storing tonal ranges is the Tonal Range Settings folder in
the Phase One hierarchy.

To Load a saved tonal range settings file into the current Phase One session, click
on the Load button in the Tonal Range window. A file-finder dialog appears,
allowing you to select a previously saved file.



Undo

Menu Item: Edit ➜ Undo.

Keyboard Short-cut: Macintosh: �Z PC: Ctrl+Z

Description and Use

This function, which has a toggle action,  undoes or redoes the last  Tonal Range,
Gradation or Crop Box adjustment on a preview image.

Use it to “cancel” the last change made if the change does not have the desired
pictorial effect.
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Unsharp Masking

Menu Item: Image ➜ Unsharp Masking.

Keyboard Short-cut: Macintosh: �U PC: Alt I U

Icon:

To Display Window: Click on the icon

To  Close Window Click on the icon

Description and Use

The Unsharp Masking feature enables you to add "sharpness" to your images as
they are scanned by accenting the definition of edges and textures in your images.

The filter works by increasing contrast in areas where adjacent  pixels have rela-
tively large differences in value; areas of relatively even pixel values will be less
affected. For example, if a nearly black pixel is adjacent to a nearly white pixel, the
unsharp masking filter would make the values of these pixels black (value 0) and
white (value 255) respectively.
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When the Apply unsharp masking check box is active, filtering will be applied to
all image captures as they are scanned. To disable unsharp masking, make sure this
box is unchecked. Click on the box to toggle the setting.

The higher the number entered for Amount, the stronger the effect of the sharp-
ening filter will be. If your images appear too "blurred", then increase the sharp-
ening amount. A high value will increase contrasts, but will also reveal more noise
in your image. If your images appear noisy or speckled, then reduce the amount
of sharpening applied.

The Threshold setting allows you to specify a tolerance range to prevent overall
sharpening that might generate noise or cause other unexpected results. A typical
threshold value is between 1-10.

Radius defines the size of the area around each pixel that is taken into account
when making Unsharp Masking calculations. A larger radius gives better results,
especially for high-reolution pictures, but computation time is much slower.
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Zoom  1:1

Menu Item: Windows ➜ Zoom 1:1

Keyboard Short-cut Macintosh: � 0 PC: none

Icon:

Description and Use

Use this function to display an image viewed with Phase One software without
any enlargement or reduction.

The Zoom 1:1 function is only available for images in the Preview Window.

The zoom-size slider, part of the Cursor Tools & View Modes window, allows you
to set a zoom ration of 1:1.
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Zoom  In

Menu Item: Windows ➜ Zoom In

Keyboard Short-cut Macintosh: � + PC: none

Icon:

To Activate in Preview: Click on the icon

To Zoom In: When the cursor is displayed,  click on the image.

Description and Use

Use this function to increase the displayed size of an image viewed with Phase
One software.

To scroll around the image, change the cursor to a by holding down the Ctrl
key, or use the scroll bars.

The zoom function is available for images in the Preview Window, Gray Balance
window and the Color Info panel (cursor views).

The zoom-size slider, part of the Cursor Tools & View Modes window, is only
available in the Preview Window.
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Zoom  Out

Menu Item: Windows ➜ Zoom Out

Keyboard Short-cut Macintosh: � - PC: none

Icon:

To Activate in Preview: Click on the icon

To Zoom Out: When the cursor is displayed, hold down the Alt key
to change it to a and click on the image.

Description and Use

Use this function to reduce the displayed size of an image viewed with Phase One
software.

To scroll around the image, change the cursor to a by holding down the Ctrl
key, or use the scroll bars.

The zoom function is available for images in the Preview Window, Gray Balance
window and the Color Info panel.

The zoom-size slider, part of the Cursor Tools & View Modes window, is only
available in the Preview Window.
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Glossary

This glossary gives definitions of many of the technical words used
in this manual. The definitions used are those that most closely
apply to Phase One image capturing software.
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Glossary

Application: A computer program designed to do a certain task, such as word processing,
image manipulation, or image capture. When you work with your digital studio camera
system, you work with the Phase One application program that came with your camera
back system. The Phase One application displays the user interface, and manages and
runs all other Phase One software associated with your system.

Camera Calibration: Adjustments made by the computer to incoming camera signals
which correct for variations in the electronics, thus maintaining consistent and accurate
readings.

Camera Control Plug-in: This software contains code that enables the application to con-
trol and receive data from the camera back. 

Capture: The full process of scanning an image, applying all settings (e.g. tonal range, gra-
dation, interpolation, unsharp masking, etc.) and storing the image file on disk.

Color Cast: Discoloration in an image caused by the spectrum (color temperature) emitted
by studio lights or reflections in the studio. Colored filters are sometimes used to add a
color cast for effect.

Color Management: A system for making sure that colors are represented consistently by
the camera back, computer monitor, and output device. It assures that the colors in your
final print will match the colors in your studio.

CCD Array: The light sensitive area of the camera back.

CCD Calibration: Amplification or attenuation applied to each pixel on the CCD array. It
is used to calibrate the CCD array so that all pixels react uniformly.

Click: To press and quickly release the mouse button, usually while the mouse pointer is
over some specified part of the screen, for example “Click on OK”.

CMYK: Stands for Cyan, Magenta, Yellow, and blacK. These are the basic ink colors used in
a color printing press. In order to print your images on CMYK printers, they must be con-
verted from their scanned values (expressed in red, green, and blue) to their CMYK equiv-
alent values. Also called process separation colors.
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Glossary

Color Picker: A feature of the user interface which allows you to read the color and location
of any pixel you point to with the mouse. It is also used to select pixels for the highlight
and shadow settings.

ColorSync: A  system of color balancing used by Apple Computers Inc. that attempts to
ensure that all devices used to display and handle colored images have translatable gamut
ranges.

Color Table: The internal look- up table which modifies each pixel value. It is created from
merging the Gamma, Tonal Range, Gradation, and Gray Balance functions.

Crop: To select a reduced area of the exposure for use. When an image is cropped, only the
selected area is scanned. All other pixels are ignored.

Cropping Tool: A tool to enable you to use the mouse to define the cropping area.

Dialog Window: A window in which you can read and change settings currently used by
the application.

Double Click: To quickly press and release the mouse button twice in short succession,
usually while the mouse pointer is over some specified part of the screen.

Drag: To press and hold the mouse button while the mouse pointer is over an object you
wish to stretch, move, or copy. An outline of the object will then follow the mouse
pointer. Move the outline to the new desired location, and release the button to “drop”
the object there.

Dynamic Range: The number of levels  which are available in an image. 12-bit data has a
dynamic range of 4096. 8-bit data has a dynamic range of 256.

Exposure Area: The dimensions of the light sensitive area of the camera back which will be
scanned in the final take. The exposure area can be reduced by cropping.

File: A collection of related data that is stored on a computer, and is accessible as a single
unit. For example, all data used to make a single image is stored as a single file. The Phase
One application program is also stored as a file.
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Final Shot or Final Take: A capture which is made after examining and correcting the pre-
view shot. This is the picture you will use in your work. It is scanned, the color table is
applied, and it is stored on disk. You take a final shot by clicking on the Capture but-
ton.

Folder: Folders give you a way to organize the computer files on your hard disk. By group-
ing several related files together in a folder, you make it easier to find your files when
you want them. For example you could keep all your pictures of flowers in a folder
called “flower pictures”. You can keep folders inside of other folders, so your flower pic-
tures folder might be one of several folders kept in a folder called “Images”.

Gain: Amplification or attenuation applied to an electronic signal to make it stronger or
weaker.

Gamma: A mathematical way to represent the logarithmic way a device (e.g. CCD or
monitor) reacts to light of various intensities.

Gradation: The distribution of pixel levels in a picture. Refer to the Tutorial for a full dis-
cussion of gradation.

Gradation Curve: A curve on a graph that shows how the grey levels of an incoming image
will be appear in the output image.

Gray Balance Calibration: A process which calibrates your camera back to eliminate unde-
sirable color casts in your images.

Handles: Points on the gradation curve or cropping area which you can move by dragging
them with the mouse.

Highlight: The brightness value above which all pixels are considered white.

Icon: A picture appearing on the computer screen to represent a file, folder,  piece of hard-
ware or a function.

Image Capture: The full process of scanning an image, applying the color table, and stor-
ing the image file on disk.
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Image File: A TIFF file created by the Phase One application after you take an image cap-
ture or preview.

Interpolation: The process of reducing or increasing the size of an image. 

Look-up Table: A group of numbers used to manipulate pixel values. It contains a factor
for each pixel level possible in the image, so when a single pixel is read, the factor for
that pixel is found in the look-up table, the number is applied (added, subtracted, mul-
tiplied, divided), and the modified pixel value is saved. (see also the Glossary entry on
Color Table).

Menu Bar: A bar located at the top of the computer screen. It contains a line of pull down
menu titles and icons.

Parameter: A numeric value which describes some aspect of an object or process, such as
height, width, speed, etc.

Pixel: The smallest picture unit , having a single brightness value made up of three color
components. An image is made of thousands of pixels set out  in a rectangular array.

Preview: A low resolution shot taken to check the image and create the color table for the
final shot.

Resolution: Refers to the number of pixels per unit length in an image. High resolution
images contain more pixels than low resolution images for the same size image, and are
therefore able to produce more detailed images.

RGB: Stands for Red, Green, and Blue. This refers to the three colors which are mixed at
varying strengths to produce all shades of color possible, for example on the computer
screen. They are the primary colors of the additive light model.

Scan: The process of moving the linear CCD array across the exposure area to capture a
full two dimensional image.

Shadow: The brightness value below which all pixels are considered black.
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Sharpening: A mathematical operation on an image which increases contrasts at edges and
brings out textures in your pictures.

Shadow: The brightness value below which all pixels are considered black.

Shot: A single picture scanned, processed, and stored. Also called a take.

Take: A single picture scanned, processed, and stored, sometimes called a shot.

TIFF or .tif file: Stands for Tagged Image File format. This is a standard format for storing
image data. It is understood by most digital imaging software.

Target Colors: A target color is a highlight or a shadow point. The brightness value of a
target colour need not be pure black or white. Target color are generally used in printing
processes where a margin is allowed when printing inks close to black and white.

User Interface: The interactive graphics you see on your computer screen, including the
main window, pull down menus and pop-up windows and menus. The user interface
shows you what the computer is doing in a way that is easy for you to understand, and
translates your instructions into a form that the computer can understand.
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Index

This index allows you to find information on keywords  and icons
that do not have their own specific topic.
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For Information on: See topic:

. . . . . . . . . . . . . . . . . . . . . . . . . Crop Box

. . . . . . . . . . . . . . . . . . . . . . . . . Color Picker

. . . . . . . . . . . . . . . . . . . . . . . . . Zoom

. . . . . . . . . . . . . . . . . . . . . . . . . Tonal Range

. . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve

. . . . . . . . . . . . . . . . . . . . . . . . . Unsharp Masking

. . . . . . . . . . . . . . . . . . . . . . . . . Grid

. . . . . . . . . . . . . . . . . . . . . . . . . Mask

. . . . . . . . . . . . . . . . . . . . . . . . . ColorSync

. . . . . . . . . . . . . . . . . . . . . . . . . Color Warning

. . . . . . . . . . . . . . . . . . . . . . . Lock

. . . . . . . . . . . . . . . . . . . . . . . . . . Image File Info

. . . . . . . . . . . . . . . . . . . . . . . . . . . Capture Specification

. . . . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve

. . . . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve
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For Information on: See topic:

. . . . . . . . . . . . . . . . . . . . . . . . . Settings

. . . . . . . . . . . . . . . . . . . . . . . . . ISS Control

. . . . . . . . . . . . . . . . . . . . . . . . . Curves

. . . . . . . . . . . . . . . . . . . . . . . . . BatchTool in BatchTool Manual

. . . . . . . . . . . . . . . . . . . . . . . . . Embed Copyright

. . . . . . . . . . . . . . . . . . . . . . . . . Focus Tool in Focus Tool Manual

. . . . . . . . . . . . . . . . . . . . . . . . . Quicktime Tool

. . . . . . . . . . . . . . . . . . . . . . . . . Scan Progress

3x3 Pixels . . . . . . . . . . . . . . . . . . . . . . Color Picker

5x5 Pixels . . . . . . . . . . . . . . . . . . . . . . Color Picker

Absolute colorimetric. . . . . . . . . . . . . . Profiles

Add entrance . . . . . . . . . . . . . . . . . . . . Capture File

Add path . . . . . . . . . . . . . . . . . . . . . . . Capture File

Adobe Photoshop . . . . . . . . . . . . . . . . Capture File

After Capture. . . . . . . . . . . . . . . . . . . . Capture File

Alt (keyboard) . . . . . . . . . . . . . . . . . . . Capture Viewer or Lock

Apply. . . . . . . . . . . . . . . . . . . . . . . . . . Gray Balance

Apply Color Management . . . . . . . . . . Color Management

Apply unsharp masking . . . . . . . . . . . . Unsharp Masking
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For Information on: See topic:

Amount . . . . . . . . . . . . . . . . . . . . . . . . Unsharp Masking

Artist . . . . . . . . . . . . . . . . . . . . . . . . . . Image File Info

ASA Rating . . . . . . . . . . . . . . . . . . . . . Settings

Auto . . . . . . . . . . . . . . . . . . . . . . . . . . Tonal Range

Best . . . . . . . . . . . . . . . . . . . . . . . . . . . Profiles

Bring to Front . . . . . . . . . . . . . . . . . . . Capture File

Browse. . . . . . . . . . . . . . . . . . . . . . . . . Capture File

Camera . . . . . . . . . . . . . . . . . . . . . . . . Profiles or Settings

Camera to monitor . . . . . . . . . . . . . . . Profiles

Camera to printer . . . . . . . . . . . . . . . . Profiles

Cancel . . . . . . . . . . . . . . . . . . . . . . . . . Gray Balance

Capture Conditions. . . . . . . . . . . . . . . PowerPhase Control

Channel. . . . . . . . . . . . . . . . . . . . . . . . Tonal Range

Computer . . . . . . . . . . . . . . . . . . . . . . Image File Info

Copyright . . . . . . . . . . . . . . . . . . . . . . Image File Info

Create thumbnails . . . . . . . . . . . . . . . . Capture file

Ctrl . . . . . . . . . . . . . . . . . . . . . . . . . . . Capture Viewer

Current . . . . . . . . . . . . . . . . . . . . . . . . Color Info

Current . . . . . . . . . . . . . . . . . . . . . . . . Gray Balance

Description . . . . . . . . . . . . . . . . . . . . . Gradation Curve or Tonal Range

Draft . . . . . . . . . . . . . . . . . . . . . . . . . . Profiles

Drag Mark. . . . . . . . . . . . . . . . . . . . . . Color Info

Draw color picker frame . . . . . . . . . . . Color Picker
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For Information on: See topic:

Draw Crop Box . . . . . . . . . . . . . . . . . . Mask

Extension. . . . . . . . . . . . . . . . . . . . . . . Capture file

Gamut. . . . . . . . . . . . . . . . . . . . . . . . . Profiles

Gradation . . . . . . . . . . . . . . . . . . . . . . Gradation Curve

Gray out image . . . . . . . . . . . . . . . . . . Color Warning

Height . . . . . . . . . . . . . . . . . . . . . . . . Capture Specification

Highlight. . . . . . . . . . . . . . . . . . . . . . . Tonal Range

Highlight Warning . . . . . . . . . . . . . . . Color Warning

High resolution . . . . . . . . . . . . . . . . . Capture Specification

History . . . . . . . . . . . . . . . . . . . . . . . . Capture Specification

Horizontal . . . . . . . . . . . . . . . . . . . . . . Grid

If selected. . . . . . . . . . . . . . . . . . . . . . . Gray Balance

Input . . . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve

Image file attributes . . . . . . . . . . . . . . . Capture File

Image Folder . . . . . . . . . . . . . . . . . . . . Capture File

Load . . . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve or Tonal Range

Low resolution . . . . . . . . . . . . . . . . . . Capture Specification

Lowest resolution . . . . . . . . . . . . . . . . Capture Specification

Matching. . . . . . . . . . . . . . . . . . . . . . . Profiles

Medium resolution . . . . . . . . . . . . . . . Capture Specification

Monitor. . . . . . . . . . . . . . . . . . . . . . . . Profiles

Next Image . . . . . . . . . . . . . . . . . . . . . Capture Specification

Opacity . . . . . . . . . . . . . . . . . . . . . . . . Mask
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For Information on: See topic:

Open Image Using. . . . . . . . . . . . . . . . Capture File

Output . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve

Output Data . . . . . . . . . . . . . . . . . . . . Color Management

Output Image . . . . . . . . . . . . . . . . . . . Capture Specification

Panel Alignment . . . . . . . . . . . . . . . . . Appearance

Perceptual . . . . . . . . . . . . . . . . . . . . . . Profiles

Pick Position . . . . . . . . . . . . . . . . . . . . Color Info

Pick Position . . . . . . . . . . . . . . . . . . . . Gray Balance

Point Sample . . . . . . . . . . . . . . . . . . . . Color Picker

Preserve Color Balance. . . . . . . . . . . . . Tonal Range

Preview . . . . . . . . . . . . . . . . . . . . . . . . Color Info

Printer . . . . . . . . . . . . . . . . . . . . . . . . . Profiles

Radius . . . . . . . . . . . . . . . . . . . . . . . . . Unsharp Masking

Relative colorimetric . . . . . . . . . . . . . . Profiles

Rendering intent . . . . . . . . . . . . . . . . . Profiles

Rendering quality . . . . . . . . . . . . . . . . Profiles

Reset . . . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve

Reset . . . . . . . . . . . . . . . . . . . . . . . . . . Gray Balance

Resolution . . . . . . . . . . . . . . . . . . . . . . Capture Specification

Restore . . . . . . . . . . . . . . . . . . . . . . . . Gray Balance

Saturation . . . . . . . . . . . . . . . . . . . . . . Profiles

Saturated pixels . . . . . . . . . . . . . . . . . . Color Warning

Sample Size . . . . . . . . . . . . . . . . . . . . . Color Picker
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For Information on: See topic:

Save . . . . . . . . . . . . . . . . . . . . . . . . . . . Gradation Curve or Tonal Range

Scan method . . . . . . . . . . . . . . . . . . . . Capture Specification

Scroll . . . . . . . . . . . . . . . . . . . . . . . . . . Capture Viewer

Scroll . . . . . . . . . . . . . . . . . . . . . . . . . . Zoom In

Sensitivity . . . . . . . . . . . . . . . . . . . . . . Settings

Shadow . . . . . . . . . . . . . . . . . . . . . . . . Tonal Range

Shadow Warning . . . . . . . . . . . . . . . . . Color Warning

Slide Reproduction . . . . . . . . . . . . . . . PowerPhase Control

Start. . . . . . . . . . . . . . . . . . . . . . . . . . . Capture

Stop. . . . . . . . . . . . . . . . . . . . . . . . . . . Capture

Target Colors . . . . . . . . . . . . . . . . . . . . Tonal Range

Threshold . . . . . . . . . . . . . . . . . . . . . . Unsharp Masking

Thumbnail . . . . . . . . . . . . . . . . . . . . . Capture file

Toolbar Alignment . . . . . . . . . . . . . . . Appearance

Unbalanced . . . . . . . . . . . . . . . . . . . . . Gray Balance

Units of measurements . . . . . . . . . . . . Capture Specification

Vertical . . . . . . . . . . . . . . . . . . . . . . . . Grid

Warning Triangle . . . . . . . . . . . . . . . . . Capture Specification

Width . . . . . . . . . . . . . . . . . . . . . . . . . Capture Specification

Windows . . . . . . . . . . . . . . . . . . . . . . . Capture Viewer

Phase One Image Capture Software - Reference Manual

119



Phase One Image Capture Software - Reference Manual

120


